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MAZMUNNOMA 

Mazkur bitiruv ishi ingliz tili zamonlarini o'rgatuvchi mobil dastur tuzish 

mavzusiga bag’ishlangan. Dasturda foydalanuvchiga albatta interfaollikni taqdim 

etadigan, ya’ni inson va mobil qurilma o‘rtasida buyruqlar va savol javoblar 

almashinuvini ta’minlab, dialog muhitini yaratadigan dasturiy mahsulot taqdim 

etiladi. Dasturning yaratilishida Ingliz tilining barcha 12 zamoni, har bir zamon 

uchun o‘z formulalari, hamda bu formulalarga mols ravishda misollar keltirib 

o‘tilgan. 

 

АННОТАЦИЯ 

Этот выпускной проект посвящен созданию мобильного приложения, 

предназначенного для обучения английскому языку. Программа 

предоставляет программное обеспечение, которое создает диалоговое 

окружение, обеспечивающее интерактивное взаимодействие между 

человеком и мобильным устройством, предоставление команд и обмен 

ответами и ответами. При создании программы все 12 периодов на 

английском языке имеют свои собственные формулы для каждого времени и 

примеры этих формул. 

 

ANNOTATION 

This graduation project is dedicated to creating a mobile application 

designed to teach English tenses. The program provides software that creates a 

dialog environment that ensures interactive interaction between the person and the 

mobile device, providing commands and question-and-answer exchange. In the 

creation of the program, all the 12 tenses in English have their own formulas for 

each time, and examples of these formulas. 
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INTRODUCTION 

In the Republic, as in all spheres, a great attention is paid to the effective 

use of information technologies in the education system. Therefore, several laws, 

presidential decrees and resolutions on the development of information 

technologies have been adopted in our country. In particular, the Resolution of the 

President of the Republic of Uzbekistan «On Measures for the Further 

Implementation and Development of Modern Information and Communication 

Technologies» (March 21, 2012) and others. Design, development and use of e-

books in the educational process has become a topical issue since many of them 

have been widely used in the field of education. Recently, various e-learning 

editions have been created to cover the range of simple hypertextbooks to complex 

systems of distance learning. 

The purpose of the graduation exams is to study the ways of using 

information and communication technologies in the learning process; study 

software production technologies; Creating a mobile tutorial for the English 

language, and formulating and implementing multimedia products in the database. 

Object of research and subject: Get acquainted with the importance of 

software product. Working with Android Studio Environment. Java programming 

language and projects can be created. Get acquainted with database management 

systems. Working with SQL queries and learning it perfectly. Get acquainted with 

the SQL Server environment. Develop a database database project in SQL Server. 

Working with queries, using it in Java, and applying the created MB to the 

program. 

Purpose and tasks of work: Comparative analysis of educational 

products. Studying methodological bases and stages of creation of teaching aids in 

mobile devices; study ways to create information resources on mobile devices; 

development of a visualized program based on international experience. Collect 

enough literature on the topic. Work with Android Studio and Java programming 

language. Learn SQL queries. Using a Microsoft SQL Server environment. 



Explore links and regular forms between tables. Writing SQL queries and applying 

them to the Java language. Creating a database and user interface in the program. 

Research Methods and Techniques: Java dasturlash tilini imkoniyatlarini 

ko’rsatish, zamonaviy texnologiyalardan foydalanish. Zamonaviy dasturlash 

usullaridan foydalanish. Ma’lumotlar bazasini boshqarish tizimlarini 

imkoniyatlaridan foydalanish va yaratilgan MB dasturda to’laqonli ishlatish. 

Size and structure of the work: Introduction consists of three chapters, an 

introduction, a list of publications used. Chapter I Theoretical foundations for the 

development of the English language curriculum, including the use of mobile 

devices and the use of software on mobile platforms. Use multimedia software for 

creating educational content. In the development of mobile applications, the 

operational and technical requirements were considered. Part II Preparation of a 

technical project for the creation of the English language curriculum. Creating 

software algorithm. Part III Provides information on how to use the program that 

describes the English Language Teaching Program and its capabilities, as well as 

instructions for using the program. 

 



I CHAPTER. MULTIMEDIA PROGRAMS IN THE TABLE 

1.1. Multimedia tools and their use 

Multimedia tools are a set of technical and software tools that enable a 

person to communicate with the computer using the natural environment: audio, 

video, graphics, texts, animation, and more. Multimedia is a rapidly developing 

modern information technology. Its distinguishing marks include: 

a) Different types of information: Traditional (text, tables, decorations, 

etc.), original (music, video clips, telecast, animation, etc.) integration into one 

software product. This integration can be done by computer-controlled electronic 

recording of various types of data recording and mirroring: microphones, audio 

systems, optical CDs, television, video recorders, camcorders, etc. 

b) Unlike text and graphics that are static in their nature, audio and video 

are only considered at a specific time interval. The central processor for fast and 

easy access to video and audio information on the computer is the ability of the 

data transmission tire, the capacity for fast and video memory (mass memory), 

volume and PC the speed of exchange of input and output channels is about 

doubled; 

v) A new level of interactive dialogue between «human and computer», in 

which the user has a broader and more comprehensive information that can 

improve learning, work or leisure. Training of pupils and retraining of personnel 

on the basis of multimedia tools is one of the topical issues of today. The concept 

of multimedia came into our lives in the early 85's. What is his question about 

him? Many experts analyze this term differently. In our opinion, multimedia is a 

combination of audio, video, text, graphics and animation (object space 

movements) on the basis of the programmatic and technical means of informatics, 

in a comprehensible form of delivery of educational materials to students. 

Nowadays, every computer sold is not available without multimedia 

content. Attempts to broaden the scope of the computer science in the 1970s were 

largely due to the low productivity of computers. Practice shows that learning 



multimedia tools is twice more effective and can be delayed. Up to 30% of the 

time spent on learning multimedia tools can save time, and the knowledge gained 

will stay in memory for a long time. If the reader accepts the content (video), the 

memory of the memory will increase by 25-35%. Additionally, the content of the 

audio, video and graphics are intensified, and the memory of the material increases 

by 75%. We have reiterated this in the process of studying foreign languages on 

the basis of multimedia tools. 

Teaching students through multimedia tools has the following advantages: 

1) the materials can be deeper and better absorbed; 

2) the desire to communicate closely with new areas of education: 

3) the ability to save time as a result of the time spent studying; 

4) The knowledge gained in the memory is kept indefinable and practically 

used in practice. 

It is worth mentioning that, for example, the IMF, such as the World 

Monetary Fund, the Universal Bank, and the European Union Commission, have 

extensive experience in retraining. 

On the spot, there are some objective problems with the widespread use of 

multimedia tools. The most important of these is the production of computer 

programs as a guide for learning materials, laws and other guidelines for students. 

The use of multimedia components in developed computer applications requires 

the use of compact discs. Today, CDs of this type are not available in our country. 

They require advance payment of a certain amount of money. 

In our opinion, the extensive use of modern computer technology in the 

process of training and retraining of pupils will further develop the qualified and 

highly qualified specialists. 

 Distant learning is one of the most-current trends in today's education, with 

teachers and students being trained at a distance. The fact that the teacher and the 

student are in a particular situation requires that the teacher organize educational 

activities on the basis of computers such as computers, satellite communication, 



cable television. Rapid development of modern computer technologies, especially 

the development of information channels, contributes to specific historical 

developments in the telecommunications sector. By bringing together all the 

educational institutions and companies involved in business in the remote form, it 

leads to a higher level of teaching and business operations. 

Distant learning techniques include the following technologies: 

Interactive technologies: 

- audioconferences; 

- videoconferences; 

- videoconferences on your desktop; 

- electronic conferences; 

- voice communications; 

- two-way satellite communication; 

- virtual existence; 

Non-Interactive Technology: 

- printed materials; 

- audiocassettes; 

- video cassettes; 

- one-way satellite communication; 

- television and radio broadcasts; 

- floppy disks and CD-ROMs. 

First of all, it was designed for distance learning, geographically remote 

schools and academic education. However, the development of modern 

information and telecommunication technologies has led to the development of 

natural teaching processes. As a result, distance learning techniques have been 

widely used in many schools, traders and industrial enterprises, and have been 

instrumental in applying new teaching styles. An analysis by the International 

Council on Distant Learning shows that more than 10 million students worldwide 

are currently studying this method. In the United States, new training centers are 



being set up to teach this technique. Thus, they are moving forward to prepare and 

retrain national personnel on time. 

The distant style has the following advantages: 

a) Creative learning environment. On the basis of many available methods, 

the teacher teaches the student, and the reader only reads the material. On the basis 

of the recommended distance learning method, the students themselves will find 

the information they need from a computerized information bank and exchange 

their experiences with others on an e-network basis. This ensures that learners 

communicate well with others and encourage them to receive such coaching. 

b) Independent learning opportunities. Distant-based teaching includes the 

stages of primary, secondary, university, correspondence, and upgrading. Various 

level inspectors can work on their own schedules and communicate with students 

at their own level. 

c) Significant changes in the workplace. Distant-based teaching creates 

favorable conditions for millions of people and for those without learning to work. 

In this way, teaching can play a very important role in the training of staff, ie, 

without geographical and financial difficulties, it can gain knowledge. 

d) A new and effective tool for teaching and learning. Statistical data 

suggests that distance learning can be as effective as learning from production. In 

addition, distance-based learning is also avoided by the university. The advantage 

of students or students on this basis over others is that they are provided with the 

best quality materials and teachers. Based on the teaching and learning 

methodology, a teacher should be free of the learning environment in the 

classroom. Based on the distant learning curriculum, tax inspectors can travel 

internationally through the internet. At the same time, the change in the teaching 

methodology must also change. 

Currently, the Direct Access Internet Access Service is used on an e-mail, 

computer conferences and electronic data base for remote learning. The 

development of an information hot channel provides a new hypermedia system that 



combines three main Internet access services and helps to further enhance the user 

interface. For instance, availability of digital technologies, conferencing and 

multimedia computers has allowed for video conferencing through the Internet. 

Thus, such a giant informational network creates enormous opportunities for the 

readers to have a modern knowledge based on their distance learning, regardless of 

their time or place. 

Nowadays, the emergence of computer-aided reproduction of sound and 

image, which is commonly used for the processing of texts and mathematical 

formulas, undoubtedly affects all human activity. 

1.2. Using mobile applications in mobile devices 

A mobile application, most commonly referred to as an app, is a type of 

application software designed to run on a mobile device, such as a smartphone or 

tablet computer. Mobile applications frequently serve to provide users with similar 

services to those accessed on PCs. Apps are generally small, individual software 

units with limited function. This use of app software was originally popularized by 

Apple Inc. and its App Store, which offers thousands of applications for the 

iPhone, iPad and iPod Touch. A mobile application also may be known as an app, 

web app, online app, iPhone app or smartphone app. Mobile applications are a 

move away from the integrated software systems generally found on PCs. Instead, 

each app provides limited and isolated functionality such as a game, calculator or 

mobile web browsing. Although applications may have avoided multitasking 

because of the limited hardware resources of the early mobile devices, their 

specificity is now part of their desirability because they allow consumers to hand-

pick what their devices are able to do. 

The simplest mobile apps take PC-based applications and port them to a 

mobile device. As mobile apps become more robust, this technique is somewhat 

lacking. A more sophisticated approach involves developing specifically for the 

mobile environment, taking advantage of both its limitations and advantages. For 

example, apps that use location-based features are inherently built from the ground 



up with an eye to mobile given that the user does not have the same concept of 

location on a PC. If you have a smart phone or other mobile device, you probably 

use apps – to play games, get turn-by-turn directions, access news, books, weather, 

and more. Easy to download and often free, mobile apps can be so much fun and 

so convenient that you might download them without thinking about some key 

considerations: how they’re paid for, what information they may gather from your 

device, or who gets that information. You can access the internet using a data plan 

tied to your phone service, or through a Wi-Fi hotspot. Phone companies generally 

charge a monthly fee for a data plan that can connect you to the internet. 

Wi-Fi connections usually are faster, but you have to be in range of a hotspot 

to use one. Most public Wi-Fi hotspots – like those in coffee shops, airports, and 

hotels – don't encrypt the information you send over the internet and are not 

secure. Get tips for using public Wi-Fi. To set up a home wireless network, you'll 

need to pay for internet access and a wireless router, and you’ll want to take steps 

to secure the network. When you sign up with an app store or download individual 

apps, you may be asked for permission to let them access information on your 

device. Some apps may be able to access: 

 your phone and email contacts 

 call logs 

 internet data 

 calendar data 

 data about the device’s location 

 the device’s unique IDs 

 information about how you use the app itself 

Some apps access only the data they need to function; others access data 

that’s not related to the purpose of the app. 

Remember that someone may be collecting data on the websites you visit, 

the apps you use, and the information you provide when you’re using the device – 

whether it’s the app developer, the app store, an advertiser, or an ad network. And 

https://www.consumer.ftc.gov/articles/0014-tips-using-public-wi-fi-networks
https://www.consumer.ftc.gov/articles/0013-securing-your-wireless-network


if they’re collecting your data, they may share it with other companies. If you are 

concerned about how your information is being shared, check the “privacy” 

settings on your device or look for ways to “opt-out” of data collection in the app 

privacy policy. 

It’s not always easy to know what data a specific app will access, or how it 

will be used. Before you download an app, consider what you know about who 

created it and what it does. The app stores may include information about the 

company that developed the app, if the developer provides it. If the developer 

doesn’t provide contact information – like a website or an email address – the app 

may be less than trustworthy. 

If you’re using an Android operating system, you will have an opportunity to 

read the “permissions” just before you install an app. Read them. It’s useful 

information that tells you what information the app will access on your device. Ask 

yourself whether the permissions make sense given the purpose of the app; for 

example, there’s no reason for an e-book or “wallpaper” app to read your text 

messages. 

Some apps use specific location data to give you maps, coupons for nearby 

stores, or information about who you might know nearby. Some provide location 

data to ad networks, which may combine it with other information in their 

databases to target ads based on your interests and your location. 

Once an app has your permission to access your location data, it can do so 

until you change the settings on your phone. If you don’t want to share your 

location with advertising networks, you can turn off location services in your 

phone’s settings. But if you do that, apps won’t be able to give you information 

based on your location unless you enter it yourself. 

Your phone uses general data about its location so your phone carrier can 

efficiently route calls. Even if you turn off location services in your phone’s 

settings, it may not be possible to completely stop it from broadcasting your 

location data. Developers want to provide their apps as inexpensively as possible 



so lots of people will use them. If they sell advertising space in the app, they can 

offer the app for a lower cost than if it didn’t have ads. Some developers sell space 

in their apps to ad networks that, in turn, sell the space to advertisers. Your phone 

may indicate when updates are available for your apps. It’s a good idea to update 

the apps you’ve installed on your device and the device’s operating system when 

new versions are available. Updates often have security patches that protect your 

information and your device from the latest malware. Most app stores include user 

reviews that can help you decide whether to download. But some app developers 

and their marketers have posed as consumers to post positive comments about their 

own products. In fact, the Federal Trade Commission recently sued a company for 

posting fake comments about the apps it was paid to promote.  

1.3. Use multimedia when creating educational content 

Today, the most popular theme is to create a multimedia project. Here 

everyone can demonstrate his creative personality, intelligence, knowledge and 

subtle taste. Unfortunately, multimedia projects can not be prepared without 

presentation preparation and database creation and programming, but there are 

specific software that can study their processing technology and have 

multifunctional processing tools. 

We teach you to do this with practical software tools. Not just how you use 

tools, but also the technology of creating multitimedia products. What is a 

multimedia product? It is very similar to a documentary, but it is a product that is 

available on the computer. There are music, color effects, motion and animation, 

and sound. What is the main thing in your multimedia product? As in every film, 

this is a scenario. You have to be a screenwriter, a director, a painter, and an 

operator at the same time. Electronic textbooks This tutorial is a collection of 

compact discs, utilizing special software to help you make the book easy to use. It 

is important that the information provided in the preparation of electronic 

textbooks be accessible, interesting and relevant to users. Not only does it focus on 

the subject, but it also needs to learn how to present it in pieces according to the 



mobile device screen area. As a director and artist, you need to think of each frame 

and its relationship. Predictingly you will need to create separate slides, fragments 

and databases. Only then can it be possible to trace all of the pre-made tracks. 

When it comes to device encyclopedias, electronic textbooks, programs for 

recreation and learning, and much more, nowadays a great deal of attention is paid 

to creating a multimedia product. 

What is a multimedia product? 

First, it is a software product that creates a dialog environment, providing 

interactive content for the user, that provides teams and question-and-answer 

exchange between a person and a computer. 

Second - an environment where various video and audio, animation effects 

are used. It reminds the viewer of a video that allows him or her to choose a script. 

Multimedia product - an interactive, computer-generated product that can include 

music, video clips, animations, graphics and slide gallery, various databases and 

more. Multimedia products can be divided into: 

* Encyclopedias; 

* Teaching applications; 

* Thinking Software; 

* Software for Children; 

* Games. 

In recent years, multimedia products have become more affordable. Their 

use is not always the same. When buying various multimedia equipment you 

should pay attention to the following indicators: 

* Quality and reliability of the material provided; 

* Quality of the given graphic material; 

* Voice guitar (text, musical ornaments etc.); 

* Video content and its quality; 

* Interactivity (viewing in different directions, in-depth study, printing, etc.); 

* Friendly interface. 



Not all ready-made multimedia products meet these requirements, and your 

personal interests may differ from those recommended by the authors. In this case, 

you can develop your own software product that opens the topic you selected and 

create your own custom interface. Multimedia product development 

Despite the difficult and costly process, not only programmers, but also 

many artists and designers are doing this work. 

To create a multimedia product, you can: 

It requires working with a team of qualified programmers 

programming language. Instrumental tools, such as Macromedia Director, 

Formula GraphicsMultimedia System, Multimedia Creator, Asymetrix ToolBook, 

AuthorWare Professional, and more. Projects created in this way are somewhat 

cheaper and therefore not as universal, and the tools they use are limited, but 

skilled users can work with these tools. 

Multimedia software for educational purposes can be developed using 

Microsoft Office software, and for the preparation of materials, you can use 

PhotoShop, Adobe Premier or Vstudio2 (Video Recording), Stoik Software (Image 

Processing and Morphing) audio recording and reproduction). The mobile software 

products often contain content that you can use, such as Access or Works. A 

picture or clip presentation is accomplished by using PowerPoint. Interviews are 

used to help you get more details. First of all, you can create a Mobile Project that 

will teach you, and you can develop lessons or thematic encyclopedias (music, 

favorite artists, celebrity artists, cinema news, etc.) on specific themes. You need to 

have three types of software: 

* Preparation of material that should be included in the multimedia product; 

* product self creation. 

* Application of the product. 

General Explanation of Material Design Software The material included in 

the multimedia product may be presented in the form of images, audio, and video 

recordings. These are different types of information available on their software 



tools, which have the tools to work. Below are some of the relatively popular 

software products for different types of data. Graphic Objects When working with 

graphic objects, you need to distinguish two forms of activity: scanning and 

creating images. Multimedia tools are a set of technical and software tools that 

enable a person to communicate with the computer using the natural environment: 

audio, video, graphics, texts, animation, and more. 

Teaching students through multimedia tools has the following advantages: 

a) the materials are deeper and more accessible; 

b) the desire to engage more closely with new areas of education: 

c) achieving time-savings as a result of curriculum downtime; 

g) The knowledge gained will be kept in memory for a long time and 

practiced in practice. 

The most important feature of mobile technology is its ability to influence 

the user in the work of interactive media. Over the last several years, many mobile 

software products have been created and created: encyclopedias, instructional 

programs, computer presentations, and more. 

Mobile technology allows you to manage information, which can be 

interactive. Mobile applications provide direct access to information. The user sees 

all the information provided and can use all of his interests. Receiving material 

does not require much time and effort. 

Unlike other formats of multimedia data, multimedia software can include 

thousands of pages of text, thousands of images and images, audio and video 

recordings, animations and three-dimensional graphics for up to a few hours, 

ensures that the duration of its use and storage is substantial. The sincere 

presentation is the only and most modern form of information delivery today. 

These text information, pictures, slideshow, voice-enhanced audio, videotapes and 

animation, three-dimensional 

graphics software. Presentation Information the main difference from other 

forms of presentation is their content enrichment and interactivity, ie the tendency 



to change in the established format and the attitude towards user activity. In 

addition, the presentation can also be your site's key. That is, when you have 

Internet access, you can get the latest information from the company's website by 

simply clicking the mouse over the presentation. 

Multimedia technologies (multi - media, media) allow you to use multiple 

methods of information simultaneously: text, graphics, animation, video tape and 

sound. The most important feature of multimedia technologies is its ability to 

influence the user in the interactive media environment. Over the past few years, 

many mobile software products have been created and created: encyclopedias, 

instructors, presentations, and more. 

 

II CHAPTER. LEVELS OF CREATING MOBILE APPLICATION 

WHICH TEACHES ENGLISH TENSES 

2.1. Software IDE environments 

An integrated development environment (IDE) is a software application that 

provides comprehensive facilities to computer programmers for software 

development. An IDE normally consists of a source code editor, build automation 

tools, and a debugger. Most modern IDEs have intelligent code completion. Some 

IDEs, such as NetBeans and Eclipse, contain a compiler, interpreter, or both; 

others, such as SharpDevelop and Lazarus, do not. The boundary between an 

integrated development environment and other parts of the broader software 

development environment is not well-defined. Sometimes a version control 

system, or various tools to simplify the construction of a graphical user interface 

(GUI), are integrated. Many modern IDEs also have a class browser, an object 

browser, and a class hierarchy diagram, for use in object-oriented software 

development. Integrated development environments are designed to maximize 

programmer productivity by providing tight-knit components with similar user 

interfaces. IDEs present a single program in which all development is done. This 

program typically provides many features for authoring, modifying, compiling, 

https://en.wikipedia.org/wiki/User_interface
https://en.wikipedia.org/wiki/User_interface


deploying and debugging software. This contrasts with software development 

using unrelated tools, such as vi, GCC or make. 

One aim of the IDE is to reduce the configuration necessary to piece 

together multiple development utilities, instead providing the same set of 

capabilities as a cohesive unit. Reducing that setup time can increase developer 

productivity, in cases where learning to use the IDE is faster than manually 

integrating all of the individual tools. Tighter integration of all development tasks 

has the potential to improve overall productivity beyond just helping with setup 

tasks. For example, code can be continuously parsed while it is being edited, 

providing instant feedback when syntax errors are introduced. That can speed 

learning a new programming language and its associated libraries. Some IDEs are 

dedicated to a specific programming language, allowing a feature set that most 

closely matches the programming paradigms of the language. However, there are 

many multiple-language IDEs. 

While most modern IDEs are graphical, text-based IDEs such as Turbo 

Pascal were in popular use before the widespread availability of windowing 

systems like Microsoft Windowsand the X Window System (X11). They 

commonly use function keys or hotkeys to execute frequently used commands or 

macros. Visual programming is a usage scenario in which an IDE is generally 

required. Visual Basic allows users to create new applications by moving 

programming, building blocks, or code nodes to create flowcharts or structure 

diagrams that are then compiled or interpreted. These flowcharts often are based on 

the Unified Modeling Language. 

This interface has been popularized with the Lego Mindstorms system, and 

is being actively pursued by a number of companies wishing to capitalize on the 

power of custom browsers like those found at Mozilla. KTechlab supports 

flowcode and is a popular opensource IDE and Simulator for developing software 

for microcontrollers. Visual programming is also responsible for the power 

of distributed programming (cf. LabVIEW and EICASLAB software). An early 
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visual programming system, Max, was modeled after analog synthesizerdesign and 

has been used to develop real-time music performance software since the 1980s. 

Another early example was Prograph, a dataflow-based system originally 

developed for the Macintosh. The graphical programming environment «Grape» is 

used to program qfix robot kits. 

This approach is also used in specialist software such as Openlab, where the 

end users want the flexibility of a full programming language, without the 

traditional learning curve associated with one. Integrated development 

environments, or IDEs, are software platforms that provide programmers and 

developers a comprehensive set of tools for software development in a single 

product. IDEs are built to work with specific application platforms and remove 

barriers involved in the lifecycle of software development. IDEs are used in 

development teams to build new software, apps, web pages, and services, and they 

help by providing one tool with all the features and removing the need for 

integrations. IDEs are for programming code to a specific platform or platforms, 

and have integrated features that know how the platform works and how to use the 

features of the platform through compiling code, debugging code, or intelligently 

completing code automatically. The best Integrated Development Environment 

(IDE) Software products are determined by customer satisfaction (based on user 

reviews) and market presence (based on products’ scale, focus, and influence) and 

placed into four categories on the Grid: 

 Products in the Leader quadrant are rated highly by G2 Crowd users 

and have substantial Market Presence scores. Leaders include: NetBeans, Visual 

Studio, Adobe Flash Builder, Eclipse, IntelliJ 

IDEA, WebStorm, Xcode, PyCharm, PhpStorm, and Arduino IDE 

 High Performers are highly rated by their users, but have not yet 

achieved the Market Presence of the Leaders. High Performers 

include: RubyMine, BlueJ, Flashdevelop, MyEclipse, Selenium 

IDE, CLion, Visual LANSA, and DataGrip 

https://en.wikipedia.org/wiki/Max_(software)
https://en.wikipedia.org/wiki/Synthesizer
https://en.wikipedia.org/wiki/Prograph
https://en.wikipedia.org/wiki/Dataflow_programming
https://en.wikipedia.org/wiki/Macintosh
https://en.wikipedia.org/wiki/Qfix_robot_kits
https://en.wikipedia.org/wiki/Openlab
https://www.g2crowd.com/products/netbeans/reviews
https://www.g2crowd.com/products/visual-studio/reviews
https://www.g2crowd.com/products/visual-studio/reviews
https://www.g2crowd.com/products/adobe-flash-builder/reviews
https://www.g2crowd.com/products/eclipse/reviews
https://www.g2crowd.com/products/intellij-idea/reviews
https://www.g2crowd.com/products/intellij-idea/reviews
https://www.g2crowd.com/products/webstorm/reviews
https://www.g2crowd.com/products/xcode/reviews
https://www.g2crowd.com/products/pycharm/reviews
https://www.g2crowd.com/products/phpstorm/reviews
https://www.g2crowd.com/products/arduino-ide/reviews
https://www.g2crowd.com/products/rubymine/reviews
https://www.g2crowd.com/products/bluej/reviews
https://www.g2crowd.com/products/flashdevelop/reviews
https://www.g2crowd.com/products/myeclipse/reviews
https://www.g2crowd.com/products/selenium-ide/reviews
https://www.g2crowd.com/products/selenium-ide/reviews
https://www.g2crowd.com/products/clion/reviews
https://www.g2crowd.com/products/visual-lansa-ide/reviews
https://www.g2crowd.com/products/datagrip/reviews


 Contenders have significant Market Presence and resources, but have 

received below average user Satisfaction ratings or have not yet received a 

sufficient number of reviews to validate the solution. Contenders 

include: Codenvy, Monodevelop, Oracle JDeveloper, and ColdFusion Builder 

 Niche solutions do not have the Market Presence of the Leaders. They 

may have been rated positively on customer Satisfaction, but have not yet received 

enough reviews to validate them. Niche products include: Komodo IDE, Aptana 

Studio, Code::Blocks, Rational Application Developer for WebSphere 

Software, Nuclide, Qt Creator, and Visual Studio App Center.  

When describing the programming environment, it means that exactly 

where you want to write the code you are writing. For example, a simple 

«Notepad» can also function as an IDE. In the IDE, the sum of programs or 

programs is used. Examples of modern and popular programming environments 

(Windows system) 

* PHPStorm - primarily for PHP developers; 

* VisualStudio - for .NET developers; 

* NetBeans - primarily for Java, php developers; 

* PHPDesigner - primarily for web (PHP) developers; 

The better and more comfortable the IDE, the faster and better your 

business will be. In perfect programming environment, developers are provided 

with all the conditions that require no additional software to create a project, such 

as the following options: 

* Text Editor; 

* Compiler and Interpretator; 

* Automated collector of all parts of the project (Сборщик); 

* Error detection function; 

* A library that helps you to write code syntax; 

* Code to use (emulators, browsers); 

* Terminal (for console); 
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* Reverse module (github); 

* Catalog hierarchy; 

It is true that such software environments make the programmers a bit lazy, 

but if you want to build a quick project, it will take a long time. Programming 

environments can be either free or cost free, like other programs. Depending on the 

programming language, the required IDE will be selected, and I will use the 

Sublime text editor for the web (for some reason), Visual Studio for .NET 

programming. 

IDE (Integrated Operating Environment) - Every programming language 

will have its own working environment. In this environment, the compiler will be 

the place to write code. In this work environment, some software code can also be 

written, and this environment also indicates machine gun errors. There are certain 

libraries in this working environment, and certain code is displayed to code 

correctly when writing code. An example of a simple notebook is a working 

environment, but this environment does not have a compiler, so a separate 

compiler is installed. At the same time, you need to install 2 programs together. To 

simplify these two tasks, many work environment programs have been created and 

integrated with the compiler.  

Eclipse is a programming environment designed to build programs with a 

variety of programming languages, with extensive workarounds. Eclipse 

programming environment is a product of Eclipse. Eclipse environment is 

designed to work on different platforms, Windows, Linux, and Mac OS. Eclipse 

versions are different for different OSs, but their purpose is the same. 

Android Studio is the official integrated development environment (IDE) 

for Google's Android operating system, built on JetBrains' IntelliJ IDEA software 

and designed specifically for Android development. It is available for download 

on Windows, macOS and Linux based operating systems. It is a replacement for 

the Eclipse Android Development Tools (ADT) as primary IDE for native Android 

application development. 
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Android Studio was announced on May 16, 2013 at the Google 

I/O conference. It was in early access preview stage starting from version 0.1 in 

May 2013, then entered beta stage starting from version 0.8 which was released in 

June 2014. The first stable build was released in December 2014, starting from 

version 1.0. The current stable version is 3.1 released in March 2018 

 

2.2. Android Studio software and its features 

Android Studio supports all the same programming languages of IntelliJ, 

and PyCharm e.g. Python, and Kotlin; and Android Studio 3.0 supports «Java 7 

language features and a subset of Java 8 language features that vary by platform 

version.» External projects backport some Java 9 features. 

 

2.2. Figure 1. Criterion and description 

Android Studio sets up new projects to deploy to the Android Emulator or a 

connected device with just a few clicks. Once your app is installed, Instant Run 

allows you to push code changes without building a new APK. 

To build and run your app, select Run > Run in the menu bar (or 

click Run  in the toolbar). If it's the first time running the app, Android Studio 

asks you to select a deployment target as shown in figure 1. Select a device to 

install and run your app.  
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2.2. Figure 2. The Select Deployment Target  

The Select Deployment Target dialog shows available devices, If the dialog 

says, «No USB devices or running emulators detected,» then you need to set up 

and connect your device or launch an emulator by clicking a device listed 

under Available Virtual Devices. If there are no virtual devices listed, click Create 

New Virtual Device and follow the Virtual Device Configuration wizard 

(see Create and Manage Virtual Devices). 

To display the Select Deployment Target dialog, either deselect Use same 

device for future launches or stop the app with Run > Stop app or Stop , and 

then start it again. 

When you run your app for the first time, Android Studio uses a default run 

configuration. The run configuration specifies the module to run, package to 

deploy, activity to start, target device, emulator settings, logcat options, and more. 

The default run/debug configuration launches the default project activity and 

uses the Select Deployment Targetdialog for target device selection. If the default 

settings don't suit your project or module, you can customize the run/debug 

configuration, or even create a new one, at the project, default, and module levels. 

To edit a run/debug configuration, select Run > Edit Configurations. For more 

information, see Create and Edit Run/Debug Configurations. By default, Android 

Studio builds the debug version of your app, which is intended only for use during 

development, when you click Run. 

To change the build variant Android Studio uses, select Build > Select Build 

Variant in the menu bar (or click Build Variants  in the tool windows bar), and 

then select a build variant from the drop-down menu. By default, new projects are 
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set up with two build variants: a debug and release variant. You need to build the 

release variant to prepare your app for public release. 

To build other variations of your app, each with different features or device 

requirements, you can define additional build variants.  

Menu Item Description 

Make Module Compiles all source files in the selected module 

that have been modified since the last build, and all 

modules the selected module depends on recursively. 

The compilation includes dependent source files and any 

associated build tasks. You can select the module to 

build by selecting either the module name or one of its 

files in the Project window. This command does not 

generate an APK. 

Make Project Makes all modules. 

Clean Project Deletes all intermediate/cached build files. 

Rebuild Project Runs Clean Project for the selected build variant 

and produces an APK. 

Build APK(s) Builds an APK of all the application modules in 

the current project for their selected variant. When the 

build completes, a confirmation notification appears, 

providing a link to the APK file and a link to open it 

in APK Analyzer. 

If the build variant you've selected is a debug 

build type, then the APK is signed with a debug key and 

it's ready to install. If you've selected a release variant, 

then, by default, the APK is unsigned and you must 
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manually sign the APK. However, you can 

instead configure the build process to automatically sign 

your APK. 

All built APKs are saved in project-name/module-

name/build/outputs/apk/. 

Generate Signed 

APK 

Brings up a dialog with a wizard to set up a new 

signing configuration. For more information, see Sign an 

APK. 

 

 You can view details about the build process by clicking View > Tool 

Windows > Build (or by clicking Build  in the tool window bar). The window 

displays the tasks that Gradle executes in order to build your app, as shown in 

figure 2.  

 

2.2. Figure 3. The Build output window in Android Studio 

1. Build tab: Displays the tasks Gradle executes as a tree, where each node 

represents either a build phase or a group of task dependencies. If you 

receive build-time or compile-time errors, inspect the tree and select an 

element to read the error output, as shown in figure 3 
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below.

 

2.2. Figure 4. Inspect the Build output window for error messages 

2. Sync tab: Displays tasks that Gradle executes to sync with your project files. 

Similar to the Build tab, if you encounter a sync error, select elements in the 

tree to find more information about the error. 

3. Restart: Performs the same action as selecting Build > Make Project by 

generating intermediate build files for all modules in your project. 

4. Toggle view: Toggles between displaying task execution as a graphical tree 

and displaying more detailed text output from Gradle—this is the same 

output you see in the Gradle Console  window on Android 

Studio 3.0 and earlier. 

If your build variants use product flavors, Gradle also invokes tasks to build 

those product flavors. To view the list of all available build tasks, click View > 

Tool Windows > Gradle (or click Gradle  in the tool window bar). 

If an error occurs during the build process, Gradle may recommend some 

command-line options to help you resolve the issue, such as --stacktrace or --

debug. To use command-line options with your build process: 

1. Open the Settings or Preferences dialog: 

 On Windows or Linux, select File > Settings from the menu bar. 

 On Mac OSX, select Android Studio > Preferences from the menu 

bar. 

2. Navigate to Build, Execution, Deployment > Compiler. 

3. In the text field next to Command-line Options, enter your command-line 

options. 



4. Click OK to save and exit. 

Gradle applies these command-line options the next time you try building 

your app. 

In Android Studio 2.3 and higher, Instant Run significantly reduces the time 

it takes to update your app with code and resource changes. After deploying your 

app to a target device running Android 5.0 (API level 21) or higher, you can 

click Apply Changes  to push certain code and resource changes to your 

running app without building a new APK—and, in some cases, without even 

restarting the current activity. The Run  and Debug  buttons are always 

available to you when you want to push your changes and force an app restart. 

However, you may find that using the Apply Changes  button provides a faster 

workflow for most incremental changes to your app. The Apply Changes 

 action is available only when you meet the following conditions: 

 Build your app using a debug build variant. 

 Use Android plugin for Gradle version 2.3.0 or higher. 

 Set minSdkVersion to 15 or higher in your app's module-

level build.gradle file. 

 Deploy your app to a target device running Android 5.0 (API level 21) and 

higher. 

For more information about enabling Instant Run, go to the section 

about configuring your project. 

Instant Run pushes your changes by performing a hot swap, warm swap, 

or cold swap—the type of swap it performs depends on the type of change you 

made. When you click Apply Changes  after making a code or resource change 

to your running app, Instant Run automatically determines the best way to push 

your change to the target device, as described in the following table. 

https://developer.android.com/studio/releases/gradle-plugin.html
https://developer.android.com/studio/run/#set-up-ir


Clicking Run  (or Debug ) forces a cold swap and an app restart. If 

you make a change to the app manifest or a resource referenced by the manifest, 

Android Studio always pushes your changes with a full APK reinstall. 

When performing a hot swap, your app keeps running but Android Studio 

automatically restarts the current activity. To disable this default setting: 

1. Open the Settings or Preferences dialog: 

 On Windows or Linux, select File > Settings from the menu bar. 

 On Mac OSX, select Android Studio > Preferences from the menu 

bar. 

2. Navigate to Build, Execution, Deployment > Instant Run. 

3. Uncheck the box next to Restart activity on code changes. 

If automatic activity restart is disabled, you can manually restart the current 

activity from the menu bar by selecting Run > Restart Activity. 

The Android Emulator simulates various Android phone, tablet, Wear OS, 

and Android TV devices on your computer. It comes with predefined 

configurations for popular device types and can transfer data faster than a device 

connected over USB. 

The Android Emulator provides almost all the capabilities of a real Android 

device. You can simulate incoming phone calls and text messages, specify the 

location of the device, simulate different network speeds, simulate rotation and 

other hardware sensors, access the Google Play Store, and much more. Each 

instance of the Android Emulator uses an Android Virtual Device (AVD) to 

configure its size, form factor, Android version, and various hardware 

characteristics. To effectively test your app, you should create an AVD that models 

each device type that your app is designed to support. 

Each AVD functions as an independent device, with its own private storage 

for user data, SD card, and so on. By default, the emulator stores the user data, SD 

card data, and cache in a directory specific to that AVD. When you launch the 

emulator, it loads the user data and SD card data from the AVD directory. 



To install an APK file on the emulated device, drag an APK file onto the 

emulator screen. An APK Installer dialog appears. When the installation 

completes, you can view the app in your apps list. 

To add a file to the emulated device, drag the file onto the emulator screen. 

The file is placed in the /sdcard/Download/ directory. You can view the file from 

Android Studio using the Device File Explorer, or find it from the device using 

the Downloads or Files app, depending on the device version. Use your computer 

mouse pointer to mimic your finger on the touchscreen; select menu items and 

input fields; and click buttons and controls. Use your computer keyboard to type 

characters and enter emulator shortcuts. A number of external factors can cause the 

Android Emulator to begin running slowly after an update. To begin 

troubleshooting, we recommend the following steps: 

 If you are running Android Emulator on Windows, check to see if you have 

installed Windows UpdatesKB4013429 and KB4015217. Some users 

reported improved Android Emulator performance after uninstalling these 

updates. Users also reported improved Emulator performance 

after installing Windows Update KB4015438. 

 If you have an Intel GPU (and in particular, the Intel HD 4000), ensure you 

have downloaded and installed the latest Intel graphics driver. 

 If your machine has both an Intel HD 4000 GPU and a discrete GPU, disable 

the Intel HD 4000 GPU in Device Manager to ensure you are using the 

discrete GPU. 

 Try running the emulator using the -gpu angle, -gpu swiftshader, or -gpu 

guest modes. For more information about configuring graphics acceleration 

options on the command line, see Configure Hardware Acceleration. 

 Ensure that your router is not using IPv6 addresses if you do not have an 

IPv6 connection. 
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If you are still experiencing problems with the Android Emulator running 

slowly, Report a Bug, including the necessary Android Emulator Details so we can 

investigate.  

In recent years, the JAVA language and its associated environment - the 

.NET platform - is still the main technology for software developers. It is possible 

to create optional programs that can be created in the Windows environment 

through the .NET platform. JAVA is a new language and has been developed with 

special features for this environment. Using the JAVA language, you can create 

dynamic WEB pages, software created by deployment technology, database 

components, or split windows applications. With JAVA, you can create a volunteer 

program on the Windows platform, with the exception of network or Internet 

programs. 

JAVA language is directly related to C, C ++ and Java, the most widely 

used and widely used languages in the world. At present, practitioners all know the 

language, so the transition to JAVA based on them happens without much trouble. 

As Hewley, C ++, and Java, he did not «explore the wheel», but went astray - 

essentially focusing on innovation and focusing on the previously created 

language. 

Communication between JAVA and Java is relatively complex. Both 

languages are designed to create a passcode, based on C and C ++, using their 

syntax and object model. However, there is no direct connection between these 

languages, but they are similar to cousins with more common ancestors, but with 

many signs. If you know how to work in Java, it will make it easier to master Java, 

and vice versa, many of the concepts of JAVA are useful for learning Java. 

The JAVA language has many innovative features that are discussed in this 

section. It may well be that one or several of the most important news are relevant 

to the support of software components. In other words, JAVA was originally 

designed as a language that incorporates components, such as components that 

https://developer.android.com/studio/report-bugs.html#emulator-bugs


support the components of software components (indirectly, as well as methods 

and events). 

2.3. Formation of databases in the program 

Formation of the database is one of the most urgent issues of the IT 

department today. It is almost impossible to find an information system or 

application that does not use a database management technology. 

 The database is data that consists of one or more files on the server, 

collected on that server, and is controlled by queries. The database may be logical 

and physical. The basis of a logical database is tables. Tables are composed of 

columns and rows that store data in a shared space (yacheyka). 

Many server applications, especially those distributed, use the database to 

store not only the user, but also the service and configuration information. 

Therefore, the ability to work with the database, especially Microsoft SQL Server, 

will significantly increase the effectiveness of your work and help you increase 

your value in the labor market.  

SQL (Structured Query Language) - Contextual Query Language. There are 

two types of SQL language: interactive and deployed. In most cases, both forms 

work the same way, but are used in two ways: 

The SQL Database Interactive form is provided by the database and is used 

to output outputs for the customer to use. The command entered in this form of 

SQL is immediately executed and the user will be able to see the result 

immediately. 

The SQL Language Layout is a set of SQL commands that are embedded in 

a different language program. We use this form of ice mirror. There are numerous 

groups or partitions in SQL Online and Hosted Forms. They are useful and 

conceptually useful by ANSI, but most SQL applications are not processed 

individually, so they are actually the functional categories of SQL commands. 

DDL - ANSI is a Schema Descriptor language, a collection of objects 

(tables, indexes, animations, etc.). 



DML (Data Changing Language) is a set of commands that determines 

which values are stored in a table at a random moment. 

DCD (Data Management Language) is a tool that identifies whether a user 

has allowed certain effects on certain objects. SQL Standard has been detected by 

the ANSI model and has now been adopted by the ISO model. We use the SQL 

language to create this English language tutorial. We will open the new form. 

 

   2.3.1 Figure. New window 

We will set MenuStrip to create your own. 

 

2.3.2 Figure. We add TabControl. 



 

            2.3.3 Figure. Value it. 

In the Properties section, TabPages will be selected and titles will be given. 

 

2.3.4 Figure. ListBox1 giving name 

Next, we will put TabPages into listBox1 in the SELECT section and create 

a database from the following address 

 

2.3.5 Figure. Showing an address. 



 

2.3.6 Figure. Creating the database 

After selecting this, we create a new database from the following window 

 

2.3.7 Figure. Adding base. 

 We give value the layout and click Update 

 

2.3.8 Figure. Saving the database 



  

2.3.9 Figure. Opening the base.   

We now give values to the opened database. 

 

2.3.10 Figure. Giving value. 

Now let's go to your form and let the code in the form show these addresses 

to your library 

using System.Data; 

using System.Data.SqlClient; 

From the swatches of the named database.mdf database, we will get the 

following link and call it in the form. 



 

2.3.11 Figure. Taking an address. 

And we show in the queue. 

 

2.3.12 Figure. Showing the base level.  

 

 

2.3.13 Figure. Showing the base level.  

 

III CHAPTER. METHODOLOGY OF CREATED SOFTWARE 

3.1. The English tenses program and its capabilities 

The software for creating mobile applications in higher education 

institutions can be created in many programming languages. In these programming 



languages, you can create and save JAVA, Delphi, Flash and screenshots with 

video (avi), flash (swf, flv) and other applications. We're working on Android 

Studio to create a truly mobile English tenses tutoring program.  

During creation the project I used Android studio and for database SQL 

and MySQL Server. In two ways may create database: by SQL scripts on MySQL 

sphere or with filling tables on SqlLite field. The second one is easier than the first. 

Here is given an example to both of the spheres: 

 

3.1. Figure 1. The main enterance window of MySQL Workbench software 

MySQL Workbench is a tool for visual database design that integrates the 

design, modeling, creation and operation of databases into a single seamless 

environment for the MySQL database system. It is the successor of DBDesigner 4 

from FabForce. 

MySQL Workbench is offered in two editions: 

Community Edition - distributed under a free GNU GPL license; 

Standard Edition - available on an annual paid subscription. This version 

includes additional features that improve the performance of developers and 

DBAs.  

MySQL Workbench was the first product family that was available in two 

versions. To attract developers to the main development team, the commercial 

standard version of the program (English Standard Edition) is offered on top of the 



free version (English Community Edition), distributed under the GNU GPL 

license. "Community Edition" is a full-featured product with all the main features 

of the commercial version. As the basis for all future releases, it will benefit from 

all future efforts made to develop the product. "Standart Edition" extends 

"Community Edition" with a series of modules and plug-ins that allow to optimize 

the workflow and, thus, save time and avoid mistakes. The MySQL GUI Tools 

package contains cross-platform free software (under the GNU GPL license) for 

administration of MySQL database servers, as well as for creating and 

manipulating data inside MySQL databases. This package was developed by Sun 

Microsystems, but later its development was stopped, and now it is available only 

from download archives on the MySQL site. 

The GUI Tools package has been completely replaced with MySQL 

Workbench since beta 5.2. However, MySQL Support Team continued to support 

the GUI Tools package until June 30, 2010. In future versions of MySQL 

Workbench, a migration plugin will be added, fully compatible with the MySQL 

Migration Toolkit included in the GUI Tools package. 

 

3.1. Figure 2. Workspace of MySQL workbench 

Microsoft SQL Server is a relational database management 

system developed by Microsoft. As a database server, it is a software product with 

the primary function of storing and retrieving data as requested by other software 

https://en.wikipedia.org/wiki/Relational_database_management_system
https://en.wikipedia.org/wiki/Relational_database_management_system
https://en.wikipedia.org/wiki/Microsoft
https://en.wikipedia.org/wiki/Database_server
https://en.wikipedia.org/wiki/Software_product
https://en.wikipedia.org/wiki/Software_application


applications—which may run either on the same computer or on another computer 

across a network (including the Internet). 

Microsoft markets at least a dozen different editions of Microsoft SQL 

Server, aimed at different audiences and for workloads ranging from small single-

machine applications to large Internet-facing applications with many concurrent 

users. 

 

3.1. Figure 3. Main window of database browser for SQL 

In this window you may create the table and, may enter data. We need just 

typing data and save. 

 

3.1. Figure 4. Already created table. 

CREATE TABLE `Info` ( 

 `id` INTEGER PRIMARY KEY AUTOINCREMENT, 

 `id_name` INTEGER, 

 `Definition` TEXT, 

 `Example` TEXT, 

https://en.wikipedia.org/wiki/Software_application
https://en.wikipedia.org/wiki/Concurrent_user
https://en.wikipedia.org/wiki/Concurrent_user


 `Formula` TEXT 

); 

CREATE TABLE `Names` ( 

 `id` INTEGER PRIMARY KEY AUTOINCREMENT, 

 `Name` TEXT 

); 

 

3.1. Figure 5. Creating new table. 

Android allows you to provide different resources for different devices. For 

example, you can create different layouts for different screen sizes. Then the 

system determines which layout to use based on the current device's screen size.  

1. In the Welcome to Android Studio window, click Start a new Android 

Studio project. 



 

3.1. Figure 5. Main window Android Studio 3.0 

Or if you have a project opened, select File > New Project. 

2. In the Create New Project window, enter the following values: 

 Application Name: "My First App" 

 Company Domain: "example.com" 

You might want to change the project location. Also, if you want to write a 

Kotlin app, check the Include Kotlin support checkbox. Leave the other options as 

they are. 

3. Click Next. 

4. In the Target Android Devices screen, keep the default values and 

click Next. 

 



3.1. Figure 6. Target Android devices 

5. In the Add an Activity to Mobile screen, select Empty Activity and 

click Next. 

 

3.1. Figure 7. Adding an activity to mobile 

6. In the Configure Activity screen, keep the default values and click Finish. 

After some processing, Android Studio opens the IDE. 

 

3.1. Figure 8. Main window 

Now take a moment to review the most important files. 

First, be sure the Project window is open (select View > Tool Windows > 

Project) and the Android view is selected from the drop-down list at the top of that 

window. You can then see the following files: 



app > java > com.example.myfirstapp > MainActivity  

This is the main activity (the entry point for your app). When you build and 

run the app, the system launches an instance of this Activity and loads its layout. 

app > res > layout > activity_main.xml 

This XML file defines the layout for the activity's UI. It contains 

a TextView element with the text "Hello world!". 

app > manifests > AndroidManifest.xml 

The manifest file describes the fundamental characteristics of the app and 

defines each of its components. 

Gradle Scripts > build.gradle 

You'll see two files with this name: one for the project and one for the 

"app" module. Each module has its own build.gradle file, but this project currently 

has just one module. You'll mostly work with the module's build.gradle file to 

configure how the Gradle tools compile and build your app.  

After that, I created the design of the project: 

 

3.1. Figure 9. Creating main interface. 

For running and checking project set up your device as follows: 

1. Connect your device to your development machine with a USB cable. If 

you're developing on Windows, you might need to install the appropriate 

USB driver for your device. 

https://developer.android.com/reference/android/app/Activity.html
https://developer.android.com/reference/android/widget/TextView.html
https://developer.android.com/guide/topics/manifest/manifest-intro.html
https://developer.android.com/studio/run/oem-usb.html
https://developer.android.com/studio/run/oem-usb.html


2. Enable USB debugging in the Developer options as follows. 

First, you must enable the developer options: 

a. Open the Settings app. 

b. (Only on Android 8.0 or higher) Select System. 

c. Scroll to the bottom and select About phone. 

d. Scroll to the bottom and tap Build number 7 times. 

e. Return to the previous screen to find Developer options near the 

bottom. 

Open Developer options, and then scroll down to find and enable USB 

debugging. 

Run the app on your device as follows: 

1. In Android Studio, click the app module in the Project window and then 

select Run > Run (or click Run  in the toolbar). 

2. In the Select Deployment Target window, select your device, and click OK. 

 

3.1. Figure 10. Selecting devices 



Android Studio installs the app on your connected device and starts it. You 

should now see "Hello World!" displayed in the app running on your device. 

To start developing, continue to the next lesson. 

Run on an emulator 

Run the app on an emulator as follows: 

1. In Android Studio, click the app module in the Project window and then 

select Run > Run (or click Run  in the toolbar). 

2. In the Select Deployment Target window, click Create New Virtual Device.  

3. In the Select Hardware screen, select a phone device, such as Pixel, and then 

click Next. 

4. In the System Image screen, select the version with the highest API level. If 

you don't have that version installed, a Download link is shown, so click that 

and complete the download. 

5. Click Next. 

6. On the Android Virtual Device (AVD) screen, leave all the settings alone 

and click Finish. 

 

3.1. Figure 11. Creating new virtual device. 

https://developer.android.com/training/basics/firstapp/building-ui.html


7. Back in the Select Deployment Target dialog, select the device you just 

created and click OK. 

Android Studio installs the app on the emulator and starts it. You should 

now see "Hello World!" displayed in the app running on the emulator.  

3.2. Application Guidelines 

E-learning manual is a curriculum developed at the highest scientifically-

methodological level, which is fully complied with the state educational standards 

of certain directions and specialties. Electronic educational manual - is a network 

communication system, which is provided electronically and allows instant access 

to the other part of it.  

For using program “Easy learn” you should set the application to your 

device which works on Android platform. After that you may choose the app icon 

from your menu. It looks like this: 

 

3.2. figure 1. Choosing icon from main menu  

After that the program window will open: 



 

3.2. Figure 2. Main enterance window of application 

In the main window given three labels as buttons, and they help you to begin 

learning or taking instructions. If you need a help from using the application, you 

should choose the second label “Help”. And you may read the instruction before 

using the program. 



 

3.2. Figure 3. A little instruction to using the application 

After that, click “Got it” and you will back to the main window. And if you 

choose the first “Begin learning” label you may see the next lesson’s window, 

which contains all tenses. 



 

3.2. Figure 4. After choosing the first label from main window 

Here you may scroll and see the continuing of the tenses: 

 

3.2. Figure 4. After scrolling 



If you choose one of the tenses from given window, you may get all 

information with examples in the next window.  

 

3.2. Figure 5. Explanation of every tenses with its examples 

 

3.2. Figure 6. Another view of explanations 

 



After or before learning this tenses and their formulas if you want to know 

about developer of this application you may go back to the main window: 

 

3.2. Figure 7. Main window. 

After that just click the label which is the third one “About application”.  

 

3.2. Figure 8. About application and its developer. 

Every section of this program has attended to the easy learning, that’s why 

every sentences have written clearly and understandable.  

 



 IV CHAPTER. LIFE ACTIVITIES SAFETY 

4.1. Ergonomic Computer to improve Health and Safety 

Computing with applying ergonomic principles is a great way to avoid 

discomfort, which will eventually lead to health problems as described above. 

Here are some ways of work and workplace settings that will be able to keep 

you from the discomfort of computing. The following will discuss briefly on some 

things related to ergonomics, especially matters relating to the use of computers 

and other information technology. 

 

The Control and Display Settings. 

Improper control and display control will result in inefficiency and 

frustration for the user especially if the user is in great pressure and faced with a 

large number of controls and displays. Organizing controls and displays depends 

on the domain and application created, but will include, 

Functionally, controls and displays are arranged so that they are functionally 

connected to each other; 

Sequential; control and display are organized by showing the sequence of 

their use in a particular application; 

Frequencies; controls and displays are placed according to their frequency of 

use, with the most frequently used functions being placed in easily accessible 



locations. In addition to control and display settings, the entire interface must be 

arranged in such a way that it is appropriate to the user's position. 

The Physical Environment of the Interaction 

Ergonomics also pay attention to the design of the system work environment 

such as where the machine is implemented, who uses it, how the user operates it, 

and so on. The physical environment of this system affects the user's acceptance of 

the system and even the health and safety aspects of the user. Therefore, it should 

be considered in the design of interactive systems. One consideration that is also 

related to the physical environment is the physical size of the user. Any system 

should be easy to reach by users with small body sizes including those who use 

wheelchairs, and vice versa users with large physical size are not pinched in 

system settings. In particular, users should feel comfortable and secure. 

Health Issues 

Although computer work is not a dangerous thing, it must also be thought of 

as an impact of the design of interactive systems created on the health and safety of 

users. 

There are several physical environmental factors that directly affect the 

quality of user interaction and performance; 

Physical position, the user must be able to reach all the controls comfortably 

and can see the whole display, do not have to stand for a long period of time, and 

so on; 

Temperature; temperatures that are too hot or cold will affect performance 

and health. Research shows that a person's performance will decrease at high or 

low temperatures due to loss of concentration; 

Lighting; the level of illumination must be adjusted to the work 

environment. Sufficient lighting with the right position should be provided to allow 

users to see the screen; 



Sound or noise; excessive sound can endanger health. Sound or noise levels 

should be maintained at appropriate or convenient levels as sound can be a 

stimulus to the user and a confirmation of system activity; 

Time; the time that the user needs to access the system must also be 

considered. There are some hardware that endanger health if accessed in a long 

time as CRT display is not good for pregnant women. Intensive use of computer 

technology can lead to various health problems such as stress, hand and neck 

muscle damage, eyestrain, exposure to radiation, even accidental deaths caused by 

computers. The people sitting in front of the PC or visual display terminal(VDT) in 

high-speed jobs for repeated typing will suffer health problems, commonly called 

cumulative trauma disorder or cumulative trauma disorder (CTD). The fingers, 

wrists, neck, and back can become weak and sore so they can not work. 

The Use of Color 

The colors used on the display should be indistinguishable and do not affect 

the contrast. If color is used as an indicator, it must include other information. 

Colors are also related to the general agreement and according to user expectations, 

such as red is used to mark the warning, green for a system that is running 

normally, and so on. 

The Type of Interaction 

Choosing the right type of interaction can have a good effect on the dialogue 

between the user and the computer so that the purpose of the interaction between 

the user and the computer can be achieved. There are several commonly used types 

of interactions: 

Command Line Interface (CLI) is the first form of interactive dialogue and 

is still in use today. With CLI, the user provides direct instruction to the computer 

using function keys, single character, short or long commands; 

Menus are located on the menu-driven interface, a set of options available to 

the user is displayed on the screen and can be selected using the mouse or numeric 

or alphabetic keys; 



Natural language, is an attractive mechanism komunikai. Natural language 

can understand written input, and voice. However, there are still many 

shortcomings in terms of ambiguity in the aspects of syntax and semantics; 

Q/A & Query dialogue the mechanism is that the user is given a series of 

questions in the form of yes or no answers, multiple or coded choices and guided 

step by step during the interaction process; 

Form-fills and spreadsheets are generally used for data entry and retrieval 

applications. Form-fill is a display that resembles a piece of paper with several 

fields to fill. Spreadsheets are variations of form-fill; 

WMP Interface (Windows, Icons, Menu, Pouinters) is the default interface for most interactive 

computer systems used today especially on PC and desktop workstations. 

Interactions involve at least 2 participants, ie users and systems. Both have 

complex and different characteristics in communicating and perceiving tasks and 

domains. Therefore, the interface must effectively translate the communication 

between them so that the interaction works. 

In order to achieve health and safety and comfort in work then every 

computer user should pay more attention to and care about the human and 

ergonomic factors of using the computer itself. In addition, the design and 

development of computer technology products should be more emphasis on social 

and ergonomic factors that can provide security and safety for its users. 

The law relating to health and safety issues for work with computers is 

contained in the Health and Safety (Display Screen Equipment) Regulations 1992, 

which define a 'user' as an employee who habitually uses display screen equipment 

as a significant part of their normal work. 

Though education staff are not usually working at a computer all day, the 

introduction of planning, preparation and assessment (PPA) time and the electronic 

marking of examinations have resulted in increased use of computers. 

There are health problems associated with working with computers, which 

include repetitive strain injury, eye strain, back pain and stress. 

Risk assessment 



The regulations require employers to carry out a risk assessment of users' 

workstations, which should consider the entire workstation, including equipment 

and furniture, as well as the work environment, eg lighting, temperature and leg 

room. The tasks that are being performed at the work station should be considered 

as should any special needs of individual staff. 

Display screen equipment (DSE) risk assessments should also consider those 

factors that may contribute to repetitive strain injuries such as: 

- sitting in the same position for a long period 

- awkward positioning of the wrist and hand in relation to the keyboard 

- high workload for a prolonged period of time 

- excessive use of the mouse. 

Checklist for workstations 

The DSE Regulations detail the minimum standards for workstations, which 

are summarised below. 

The display screen 

This should: 

- display well-defined characters of adequate size and spacing 

- have a stable image 

- have easily adjustable brightness and contrast 

- tilt and swivel easily to suit the user 

- be free from glare and reflections 

- use a separate base for the screen, or an adjustable table. 

The keyboard 

This should: 

- be tiltable and separate from the screen to allow the user to adopt a 

comfortable working position 

- have a space in front to provide support for the hands or arms of the user 

- have a matt surface 

- have clearly legible symbols on the keys. 



The work surface 

The work surface should: 

- provide adequate space for the user 

- have a low reflective surface 

- be of adequate size to allow the screen, keyboard, etc to be flexibly 

arranged 

- have a stable, adjustment document holder, which should be at the same 

level as the screen and at the same viewing distance. 

The work chair 

This should have a seat that is adjustable in height, with a seat back 

adjustable in height and tilt. A footrest should be available. 

The workstation/environment 

The workstation must do the following: 

- provide sufficient space for the user or the operator to alter position 

comfortably lighting must be adequate with suitable contrast between the screen 

and background glare and reflections on the screen should be avoided windows 

should be fitted with adjustable coverings to alter the daylight level. 

When a workstation is shared by more than one person, it should be assessed 

in respect of each person. 

Schools and colleges should consult their safety reps on all matters 

concerning work with computers. 

Training in using computers 

Employers are obliged to provide information and training on the health and 

safety aspects of working with computers. This should cover: 

- the importance of good posture, changing position and good keyboard 

technique 

- how to avoid glare or bright reflections in the screen 

- cleaning and adjusting the screen 

- the importance of frequent short breaks 



- using a mouse 

- health risks 

- who to report symptoms to or to contact for help 

- information about the right to eyesight tests. 

Eye tests 

Under the regulations, users have a right to eye sight tests upon starting 

computer work and at regular intervals thereafter, at the employer's expense. 

Where tests show that the user requires special spectacles/lenses for computer 

work, the employer must pay for the cost of a basic pair. 

 

4.2. Promotion of occupational safety and health 

The promotion of occupational safety and health is an organizational 

investment for the future: enterprises will benefit from promoting health in the 

workplace in the form of lower sickness-related costs and higher productivity. 

Consequently, OSH promotion in the workplace could be regarded as a modern 

corporate strategy which aims at preventing ill health at work (including work-

related diseases, accidents, injuries, occupational diseases and stress) and 

enhancing the potential and well-being of the workforce. As part of national OSH 

promotional activities, some countries organize annual awards based on certain 

criteria, including the number of accidents submitted for compensation claims, and 

continuous inspection and monitoring of hazards by the individual workplace. 

Companies that have kept good safety records are given awards in recognition of 

their efforts and to encourage others to emulate them. However, mechanisms for 

ensuring honesty and preventing under-reporting or inaccurate declaration should 

be put in place and enforced. In other instances, health promotion items, including 

hazard-monitoring equipment, safety devices, training manuals, and information 

packages on occupational safety and health are displayed at big annual events such 

as international trade fairs. Similar activities can be organized at the enterprise 

level to promote awareness about safety and health. Such activities could include 



an annual safety festival. Workers’ lifestyles, including diet, exercise, and smoking 

and drinking habits, are a key factor in health. Health education designed to 

promote good lifestyles and discourage those detrimental to health should be 

introduced into the workplace as part of the programme of OSH activities. OSH 

promotion covers a wide range of measures aimed at increasing interest in a safe 

and healthy working life. It includes: • a comprehensive system of information 

dissemination; • targeted campaigns for the different sectors of occupational safety 

and health; and • safety promotion activities, for example an annual safety week all 

over the country, featuring events centred on safety themes and culminating in a 

safety awards ceremony. The OSH programme should include strategies to 

promote wider awareness of the social and economic importance of improving 

working conditions and the environment. An OSH awareness campaign is aimed at 

acquainting both management and workers with hazards in their workplaces and 

their role and obligations in the prevention of occupational accidents, injuries and 

diseases. It fosters improved communication and work relationships at all levels of 

the business enterprise, including top management, supervisors and workers on the 

shop floor. It helps a company to achieve the key objective ofo a good safety and 

health record. Education in the context of occupational safety and health is 

designed to communicate a combination of knowledge, understanding and skills 

that will enable managers and workers in an enterprise to recognize risk factors 

contributing to occupational accidents, injuries and diseases, and be ready and able 

to prevent these factors occurring in their own work environment. OSH education 

is thus intended to foster the awareness and positive attitudes which are conducive 

to safety and health at work. Education includes training, which is a process of 

helping others to acquire skills necessary for good performance in a given job. 

Training is therefore a narrower concept than education. Training, as opposed to 

full education, may be the only option where workers have limited academic 

background (and hence their comprehension is likely to be limited), or time is 

scarce. 



Education and training provide individuals with the basic theoretical and 

practical knowledge required for the successful exercise of their chosen occupation 

or trade. Education and training must therefore also cover the prevention of 

accidents and injury to health arising out of or linked with or occurring in the 

course of work. There should be special emphasis on training, including necessary 

further training. In addition, attention should be paid to the qualifications and 

motivations of individuals involved, in one capacity or another, in the achievement 

of adequate levels of safety and health. Where there are health hazards associated 

with hazardous materials, the competent authority should make appropriate 

arrangements, in consultation and collaboration with the most representative 

organizations of employers and workers concerned: • to promote the dissemination 

of information on hazards and on methods of prevention and control; and • to 

educate all concerned about the hazards and about methods of prevention and 

control. 

 

4.3. General fire safety hazards 

Fires need three things to start – a source of ignition (heat), a source of fuel 

(something that burns) and oxygen: 

 sources of ignition include heaters, lighting, naked flames, electrical 

equipment, smokers’ materials (cigarettes, matches etc), and anything else that can 

get very hot or cause sparks 

 sources of fuel include wood, paper, plastic, rubber or foam, loose 

packaging materials, waste rubbish and furniture 

 sources of oxygen include the air around us 

Employers (and/or building owners or occupiers) must carry out a fire safety 

risk assessment and keep it up to date. This shares the same approach as health and 

safety risk assessments and can be carried out either as part of an overall risk 

assessment or as a separate exercise. 



Based on the findings of the assessment, employers need to ensure that 

adequate and appropriate fire safety measures are in place to minimise the risk of 

injury or loss of life in the event of a fire. 

To help prevent fire in the workplace, your risk assessment should identify 

what could cause a fire to start, ie sources of ignition (heat or sparks) and 

substances that burn, and the people who may be at risk. 

Once you have identified the risks, you can take appropriate action to control 

them. Consider whether you can avoid them altogether or, if this is not possible, 

how you can reduce the risks and manage them. Also consider how you will 

protect people if there is a fire. 

 Carry out a fire safety risk assessment 

 Keep sources of ignition and flammable substances apart 

 Avoid accidental fires, eg make sure heaters cannot be knocked over 

 Ensure good housekeeping at all times, eg avoid build-up of rubbish 

that could burn 

 Consider how to detect fires and how to warn people quickly if they 

start, eg installing smoke alarms and fire alarms or bells 

 Have the correct fire-fighting equipment for putting a fire out quickly 

 Keep fire exits and escape routes clearly marked and unobstructed at 

all times 

 Ensure your workers receive appropriate training on procedures they 

need to follow, including fire drills 

 Review and update your risk assessment regularly 

Dangerous substances that cause fire and explosion 

Work which involves the storage, use or creation of chemicals, vapours, 

dusts etc that can readily burn or explode is hazardous. Each year people are 

injured at work by flammable substances accidentally catching fire or exploding. 

This section does not cover explosives – our website has more detailed 

information on explosives and similar substances. It also has information on gas 

safety. 

http://www.hse.gov.uk/explosives/
http://www.hse.gov.uk/gas/
http://www.hse.gov.uk/gas/


Many substances found in the workplace can cause fires or explosions. 

These range from the obvious, eg flammable chemicals, petrol, cellulose paint 

thinners and welding gases, to the less obvious – engine oil, grease, packaging 

materials, dusts from wood, flour and sugar. 

It is important to be aware of the risks and to control or get rid of them to 

prevent accidents. 

To help prevent accidental fires or explosions, you first need to identify: 

 what substances, materials, processes etc have the potential to cause 

such an event, ie substances that burn or can explode and what might set them 

alight 

 the people who may be at risk/harmed 

Once you have identified the risks, you should consider what measures are 

needed to reduce or remove the risk of people being harmed. This will include 

measures to prevent these incidents happening in the first place, as well as 

precautions that will protect people from harm if there is a fire or explosion. 

Key points to remember 

 Think about the risks of fire and explosions from the substances you 

use or create in your business and consider how you might remove or reduce the 

risks 

 Use supplier safety data sheets as a source of information about which 

substances might be flammable 

 Consider reducing the amount of flammable/explosive substances you 

store on site 

 Keep sources of ignition (eg naked flames, sparks) and substances that 

burn (eg vapour, dusts) apart 

 Get rid of flammable/explosive substances safely 

 Review your risk assessment regularly 

 Maintain good housekeeping, eg avoid build-up of rubbish, dust or 

grease that could start a fire or make one worse. 



SUMMARY 

One of the main problems in any learning process is to improve the 

apprenticeship of learners, understand what they are learning, understand how to 

memorize and reuse them. 

As you know, most people get information through their eyesight, hearing, 

hearing, and rest. However, the information in life is not only acceptable, but also 

memorable. The memory occupies a leading position. When it comes to something 

more than what it has seen, it saves it more and more when it is created. In the 

course of this lesson, new information technologies are becoming an invaluable 

predictor. 

The Graduation Qualification Project is the last stage of a four-year process 

that focuses on the University's vocational learning. Therefore, Graduation 

Qualification Project is a job that we have chosen independently of our chosen 

(based on state educational standards) production, technical and technological 

conditions, and to find solutions to the problem of production and to be able to 

independently evaluate the obtained results. In addition, my diploma work has 

been overseen by my university as part of the classroom learning process 

(especially in special subjects). 

Of course, the diploma work involves the results of calculating the economic 

effectiveness of the results (positive only). The quality of the diploma work will be 

assessed based on the technology and the novelty of the topic solution. 

   The Graduation Qualification Project has allowed me to communicate the 

theoretical knowledge with certain technological or other related processes of 

production. The volume of the diploma work is defined and approved by the 

Council and the Chair of the University, taking into account the specifications of 

our profession, based on the requirements of state educational standards and 

standard programs. 

That's why I studied the technological processes, scientific articles, foreign 

news and abilities, patent reviews, synopsis information, and technical literature 



information, and I researched the results of these studies. This direction taught me 

to think creatively and to interpret the results even if it did not even see the 

technological process. 

Today, the most popular theme is to create mobile applications. Here 

everyone can demonstrate his creative personality, intelligence, knowledge and 

subtle taste. Unfortunately, the Mobile Application is not ready for presentations 

and databases, but there are specific software programs that can study the 

processing technology and have multifunctional handling tools. 

I've been working on a mobile application that trains the English Language 

Times for this Graduation Qualification Project. I tried to create a software product 

that created a dialog environment that ensured interactive communication between 

the user and the mobile device, allowing the user to interact with the program.   



APPLICATION  

Main Activity 

package com.example.asusx501a.englishtenses; 

 

import android.app.AlertDialog; 

import android.app.Dialog; 

import android.content.DialogInterface; 

import android.content.Intent; 

import android.support.v7.app.AppCompatActivity; 

import android.os.Bundle; 

import android.view.View; 

import android.widget.TextView; 

import android.widget.Toast; 

 

import com.example.asusx501a.englishtenses.Information.About_App; 

 

public class MainActivity extends AppCompatActivity implements 

View.OnClickListener { 

    TextView beginLear, abAppl, helpBtn; 

    private final int idd_text = 0; 

    Intent intent; 

    private Toast t; 

    public int counter = 0; 

    private long pressTime, pressCount; 

 

    @Override 

    protected void onCreate(Bundle savedInstanceState) { 

        super.onCreate(savedInstanceState); 

        setContentView(R.layout.activity_main); 

 

        beginLear = findViewById(R.id.beginLearn); 

        abAppl = findViewById(R.id.infoTxt); 

        helpBtn = findViewById(R.id.helpBtn); 

        beginLear.setOnClickListener(this); 

        abAppl.setOnClickListener(this); 

        helpBtn.setOnClickListener(this); 

    } 

 

    @Override 

    public void onBackPressed() { 

        if (pressCount++ >= 1 && System.currentTimeMillis() - pressTime < 

2000) { 

            super.onBackPressed(); 

            finish(); 

        } else { 

            pressTime = System.currentTimeMillis(); 

            Toast.makeText(getApplicationContext(), "Double press for exit!", 

Toast.LENGTH_SHORT).show(); 

        } 

    } 

 

    @Override 

    public void onClick(View view) { 

        switch (view.getId()) { 

            case R.id.beginLearn: 

                intent = new Intent("TensesList"); 

                startActivity(intent); 

                Toast.makeText(this, "Choose one of the tenses!", 

Toast.LENGTH_SHORT).show(); 



                MainActivity.this.finish(); 

                break; 

            case R.id.infoTxt: 

                /*t = new Toast(MainActivity.this); 

                t.makeText(MainActivity.this, getString(R.string.toast), 

Toast.LENGTH_SHORT).show();*/ 

                Intent intent1=new Intent(MainActivity.this, 

About_App.class); 

                startActivity(intent1); 

                break; 

            case R.id.helpBtn: 

                showDialog(idd_text); 

        } 

    } 

 

    @Override 

    protected Dialog onCreateDialog(int id) { 

        switch (id) { 

            case idd_text: 

                AlertDialog.Builder builder = new AlertDialog.Builder(this); 

                builder.setMessage(R.string.dialogMsg); 

                builder.setPositiveButton("I got it!", new 

DialogInterface.OnClickListener() { 

                    @Override 

                    public void onClick(DialogInterface dialogInterface, int 

i) { 

                        dialogInterface.cancel(); 

                    } 

                }); 

                builder.setCancelable(false); 

                return builder.create(); 

            default: 

                return null; 

        } 

    } 

} 

 

activity_main.xml 

<?xml version="1.0" encoding="utf-8"?> 

<FrameLayout xmlns:android="http://schemas.android.com/apk/res/android" 

    xmlns:app="http://schemas.android.com/apk/res-auto" 

    xmlns:tools="http://schemas.android.com/tools" 

    android:layout_width="match_parent" 

    android:layout_height="match_parent" 

    android:background="@drawable/bacxk" 

    tools:context="com.example.asusx501a.englishtenses.MainActivity"> 

 

    <RelativeLayout 

        android:layout_width="match_parent" 

        android:layout_height="match_parent" 

        android:layout_gravity="center" 

        android:background="#c1000000"> 

 

        <LinearLayout 

            android:id="@+id/linearLayout" 

            android:layout_width="wrap_content" 

            android:layout_height="wrap_content" 

            android:layout_centerInParent="true" 

            android:layout_margin="25dp" 

            android:background="@drawable/lay_fon" 

            android:orientation="vertical" 



            android:padding="10dp"> 

 

            <TextView 

                android:id="@+id/beginLearn" 

                android:layout_width="match_parent" 

                android:layout_height="wrap_content" 

                android:layout_margin="10dp" 

                android:background="@drawable/back_fon" 

                android:clickable="true" 

                android:gravity="center" 

                android:padding="10dp" 

                android:text="Begin learning" 

                android:textColor="#ffffff" 

                android:textSize="30sp" /> 

 

            <TextView 

                android:id="@+id/helpBtn" 

                android:layout_width="match_parent" 

                android:layout_height="wrap_content" 

                android:layout_margin="10dp" 

                android:background="@drawable/back_fon" 

                android:clickable="true" 

                android:gravity="center" 

                android:padding="10dp" 

                android:text="Help" 

                android:textColor="#ffffff" 

                android:textSize="30sp" /> 

 

            <TextView 

                android:id="@+id/infoTxt" 

                android:layout_width="match_parent" 

                android:layout_height="wrap_content" 

                android:layout_margin="10dp" 

                android:background="@drawable/back_fon" 

                android:clickable="true" 

                android:gravity="center" 

                android:padding="10dp" 

                android:text="About application" 

                android:textColor="#ffffff" 

                android:textSize="30sp" /> 

        </LinearLayout> 

    </RelativeLayout> 

</FrameLayout> 

 

Tenses activity 

package com.example.asusx501a.englishtenses.Tenses_List; 

 

import android.content.Intent; 

import android.database.Cursor; 

import android.database.sqlite.SQLiteDatabase; 

import android.support.v7.app.AppCompatActivity; 

import android.os.Bundle; 

import android.support.v7.widget.DefaultItemAnimator; 

import android.support.v7.widget.GridLayoutManager; 

import android.support.v7.widget.RecyclerView; 

import android.util.Log; 

import android.view.MenuItem; 

import android.view.View; 

 

import com.example.asusx501a.englishtenses.ExternalDbOpenHelper; 

import com.example.asusx501a.englishtenses.MainActivity; 



import com.example.asusx501a.englishtenses.R; 

 

import java.util.ArrayList; 

import java.util.List; 

 

public class Tenses_Activity extends AppCompatActivity { 

    static final String Database_Name = "Tenses"; 

    private SQLiteDatabase database; 

    private ArrayList<String> tense_name; 

    private ArrayList<Integer> idTense; 

 

    public int[] images = new int[]{R.drawable.present_simple, 

R.drawable.simple_past, R.drawable.future_simple, 

            R.drawable.present_continuous1, R.drawable.past_continuous, 

R.drawable.future_continuous, 

            R.drawable.present_perfect, R.drawable.past_perfect, 

R.drawable.future_perfect, 

            R.drawable.present_perfect_continuous, 

R.drawable.past_perfect_continious, R.drawable.future_perfect_continuous}; 

 

    private List<Model> modelList = new ArrayList<>(); 

    private RecyclerView recyclerView; 

    private RecyclerAdapter recyclerAdapter; 

    public Intent intent; 

 

    @Override 

    protected void onCreate(Bundle savedInstanceState) { 

        super.onCreate(savedInstanceState); 

        setContentView(R.layout.activity_tenses); 

        recyclerView = findViewById(R.id.recyclerView); 

        getSupportActionBar().setDisplayHomeAsUpEnabled(true); 

 

        idTense = new ArrayList<>(); 

        tense_name = new ArrayList<>(); 

 

        RecyclerView.LayoutManager manager = new 

GridLayoutManager(getApplicationContext(), 2); 

        recyclerView.setLayoutManager(manager); 

        recyclerView.setItemAnimator(new DefaultItemAnimator()); 

        recyclerView.setHasFixedSize(true); 

 

        ExternalDbOpenHelper dbOpenHelper = new ExternalDbOpenHelper(this, 

Database_Name); 

        database = dbOpenHelper.openDataBase(); 

        Log.i("English tenses", "It is working"); 

 

        Cursor cursor = database.query("Names", new String[]{"id", "Name"}, 

                null, null, null, null, null); 

        cursor.moveToFirst(); 

        if (!cursor.isAfterLast()) { 

            do { 

                int idt = cursor.getInt(0); 

                idTense.add(idt); 

 

                String nameT = cursor.getString(1); 

                tense_name.add(nameT); 

            } while (cursor.moveToNext()); 

        } 

        cursor.close(); 

        for (int i = 0; i < 12; i++) { 

            modelList.add(new Model(tense_name.get(i), images[i % 12])); 

        } 

        recyclerAdapter = new RecyclerAdapter(modelList); 



        recyclerView.setAdapter(recyclerAdapter); 

 

        recyclerAdapter.setOnItemClickListener(new 

RecyclerAdapter.OnItemClickListener() { 

            @Override 

            public void onItemClick(View itemView, int position) { 

                intent = new Intent("Tense_Information"); 

                intent.putExtra("tenseId", idTense.get(position)); 

                intent.putExtra("tenseName", tense_name.get(position)); 

                startActivity(intent); 

            } 

        }); 

    } 

 

    @Override 

    public boolean onOptionsItemSelected(MenuItem item) { 

        int num = item.getItemId(); 

        if (num == android.R.id.home) { 

            Intent intent1=new Intent(this, MainActivity.class); 

            startActivity(intent1); 

            finish(); 

        } 

        return super.onOptionsItemSelected(item); 

    } 

} 

 

activity_tenses.xml 

<?xml version="1.0" encoding="utf-8"?> 

<android.support.constraint.ConstraintLayout 

xmlns:android="http://schemas.android.com/apk/res/android" 

    xmlns:app="http://schemas.android.com/apk/res-auto" 

    xmlns:tools="http://schemas.android.com/tools" 

    android:layout_width="match_parent" 

    android:layout_height="match_parent" 

    

tools:context="com.example.asusx501a.englishtenses.Tenses_List.Tenses_Activit

y"> 

 

    <android.support.v7.widget.RecyclerView 

        android:id="@+id/recyclerView" 

        android:layout_width="match_parent" 

        android:layout_height="match_parent" 

        android:scrollbars="vertical" /> 

 

</android.support.constraint.ConstraintLayout> 

 

RecyclerAdapter 

package com.example.asusx501a.englishtenses.Tenses_List; 

 

import android.support.v7.widget.CardView; 

import android.support.v7.widget.RecyclerView; 

import android.view.LayoutInflater; 

import android.view.View; 

import android.view.ViewGroup; 

import android.widget.ImageView; 

import android.widget.TextView; 

 

import com.example.asusx501a.englishtenses.R; 

 



import java.util.List; 

 

public class RecyclerAdapter extends 

RecyclerView.Adapter<RecyclerAdapter.MyViewHolder> { 

 

    private List<Model> modelList; 

    private static OnItemClickListener listener; 

 

    public interface OnItemClickListener { 

        void onItemClick(View itemView, int position); 

    } 

 

    public void setOnItemClickListener(OnItemClickListener listener) { 

        this.listener = listener; 

    } 

 

    public class MyViewHolder extends RecyclerView.ViewHolder { 

        public TextView name; 

        public ImageView photo; 

        public CardView cardView; 

 

        public MyViewHolder(final View itemView) { 

            super(itemView); 

            cardView = itemView.findViewById(R.id.cardv); 

            name = itemView.findViewById(R.id.textV); 

            photo = itemView.findViewById(R.id.imgV); 

 

            itemView.setOnClickListener(new View.OnClickListener() { 

                @Override 

                public void onClick(View view) { 

                    if (listener != null) 

                        listener.onItemClick(itemView, getLayoutPosition()); 

                } 

            }); 

        } 

    } 

 

    @Override 

    public MyViewHolder onCreateViewHolder(ViewGroup parent, int viewType) { 

        View view = 

LayoutInflater.from(parent.getContext()).inflate(R.layout.item_card_view, 

parent, false); 

        return new MyViewHolder(view); 

    } 

 

    @Override 

    public void onBindViewHolder(MyViewHolder holder, int position) { 

        Model model = modelList.get(position); 

        holder.name.setText(model.getName()); 

        holder.photo.setImageResource(model.getPhoto()); 

    } 

 

    @Override 

    public int getItemCount() { 

        return modelList.size(); 

    } 

 

 

    public RecyclerAdapter(List<Model> modelList) { 

        this.modelList = modelList; 

    } 

} 



 

Model 

package com.example.asusx501a.englishtenses.Tenses_List; 

 

public class Model { 

    public String name; 

    public int photo; 

 

    public Model() { 

    } 

 

    public String getName() { 

        return name; 

    } 

 

    public int getPhoto() { 

        return photo; 

    } 

 

    public Model(String name, int photo) { 

        this.name = name; 

        this.photo = photo; 

    } 

 

    public void setName(String name) { 

        this.name = name; 

    } 

 

    public void setPhoto(int photo) { 

        this.photo = photo; 

    } 

} 

 

item_card_view.xml 

<?xml version="1.0" encoding="utf-8"?> 

<android.support.constraint.ConstraintLayout 

xmlns:android="http://schemas.android.com/apk/res/android" 

    android:layout_width="match_parent" 

    android:layout_height="wrap_content"> 

 

    <android.support.v7.widget.CardView 

        android:id="@+id/cardv" 

        android:layout_width="match_parent" 

        android:layout_height="150dp" 

        android:layout_marginLeft="5dp" 

        android:layout_marginRight="5dp" 

        android:background="@drawable/lay_fon" 

        android:layout_marginTop="5dp" 

        android:padding="2dp"> 

 

        <LinearLayout 

            android:layout_width="match_parent" 

            android:layout_height="match_parent" 

            android:orientation="vertical"> 

 

            <ImageView 

                android:id="@+id/imgV" 

                android:layout_width="match_parent" 

                android:layout_height="0dp" 



                android:layout_weight="4" 

                android:scaleType="fitXY" 

                android:src="@drawable/ic_launcher_background" /> 

 

            <TextView 

                android:id="@+id/textV" 

                android:layout_width="match_parent" 

                android:layout_height="0dp" 

                android:layout_gravity="bottom" 

                android:layout_weight="1.5" 

                android:background="#92000000" 

                android:gravity="center" 

                android:text="Hello" 

                android:textColor="#ffffff" 

                android:textStyle="italic" /> 

        </LinearLayout> 

 

    </android.support.v7.widget.CardView> 

 

</android.support.constraint.ConstraintLayout> 

 

Info_Activity 

package com.example.asusx501a.englishtenses.Information; 

 

import android.content.Intent; 

import android.database.Cursor; 

import android.database.sqlite.SQLiteDatabase; 

import android.support.v7.app.AppCompatActivity; 

import android.os.Bundle; 

import android.util.Log; 

import android.widget.TextView; 

 

import com.example.asusx501a.englishtenses.ExternalDbOpenHelper; 

import com.example.asusx501a.englishtenses.R; 

 

public class Info_Activity extends AppCompatActivity { 

    Intent intqabul; 

    String tenseName, definition, example, formula; 

    public int idsi, a; 

    static final String DatabaseName = "Tenses"; 

    private SQLiteDatabase database; 

    TextView defin, exampleV, formulaV, TenseName; 

 

    @Override 

    protected void onCreate(Bundle savedInstanceState) { 

        super.onCreate(savedInstanceState); 

        setContentView(R.layout.activity_info); 

 

        intqabul = getIntent(); 

        tenseName = intqabul.getStringExtra("tenseName"); 

        idsi = intqabul.getIntExtra("tenseId", 1); 

 

 

        ExternalDbOpenHelper dbOpenHelper = new 

ExternalDbOpenHelper(Info_Activity.this, DatabaseName); 

        database = dbOpenHelper.openDataBase(); 

        Log.i("Information Activity", "working"); 

        Cursor cursor = database.query("Info", 

                new String[]{"id", "id_name", "Definition", "Example", 

"Formula"}, 

                "id_name=" + idsi, null, null, null, null); 



        cursor.moveToFirst(); 

        if (!cursor.isAfterLast()) { 

            do { 

//                a=cursor.getInt(2); 

                definition = cursor.getString(2); 

                example = cursor.getString(3); 

                formula = cursor.getString(4); 

            } while (cursor.moveToNext()); 

        } 

        cursor.close(); 

        TenseName = findViewById(R.id.nameTense); 

        TenseName.setText(tenseName); 

 

        defin = findViewById(R.id.txtdef); 

        defin.setText("Definition: " + definition); 

 

        exampleV = findViewById(R.id.txtEg); 

        exampleV.setText("Example: " + example); 

 

        formulaV = findViewById(R.id.txtForm); 

        formulaV.setText("Formula: " + formula); 

    } 

} 

 

activity_info.xml 

<?xml version="1.0" encoding="utf-8"?> 

<android.support.constraint.ConstraintLayout 

xmlns:android="http://schemas.android.com/apk/res/android" 

    xmlns:app="http://schemas.android.com/apk/res-auto" 

    xmlns:tools="http://schemas.android.com/tools" 

    android:layout_width="match_parent" 

    android:layout_height="match_parent" 

    android:orientation="vertical" 

    

tools:context="com.example.asusx501a.englishtenses.Information.Info_Activity"

> 

 

    <TextView 

        android:id="@+id/nameTense" 

        android:layout_width="match_parent" 

        android:layout_height="wrap_content" 

        android:gravity="center" 

        android:text="Name of the tense" 

        android:textSize="15sp" 

        android:textStyle="bold|italic" /> 

 

    <ScrollView 

        android:id="@+id/scrollV" 

        android:layout_width="match_parent" 

        android:layout_height="match_parent" 

        android:layout_marginLeft="5dp" 

        android:layout_marginRight="10dp" 

        android:layout_marginTop="15dp" 

        android:orientation="vertical" 

        android:paddingTop="5dp"> 

 

        <LinearLayout 

            android:layout_width="match_parent" 

            android:layout_height="wrap_content" 

            android:orientation="vertical"> 

 



            <TextView 

                android:id="@+id/txtdef" 

                android:layout_width="match_parent" 

                android:layout_height="wrap_content" 

                android:layout_margin="5dp" 

                android:text="definition" 

                android:textSize="20sp" /> 

 

            <TextView 

                android:id="@+id/txtEg" 

                android:layout_width="match_parent" 

                android:layout_height="wrap_content" 

                android:layout_margin="5dp" 

                android:text="example" 

                android:textSize="20sp" /> 

 

            <TextView 

                android:id="@+id/txtForm" 

                android:layout_width="match_parent" 

                android:layout_height="wrap_content" 

                android:layout_margin="5dp" 

                android:text="Formula" 

                android:textSize="20sp" /> 

        </LinearLayout> 

    </ScrollView> 

</android.support.constraint.ConstraintLayout> 

 

About_App 

package com.example.asusx501a.englishtenses.Information; 

 

import android.support.v7.app.AppCompatActivity; 

import android.os.Bundle; 

import android.view.MenuItem; 

 

import com.example.asusx501a.englishtenses.R; 

 

public class About_App extends AppCompatActivity { 

 

    @Override 

    protected void onCreate(Bundle savedInstanceState) { 

        super.onCreate(savedInstanceState); 

        setContentView(R.layout.activity_about__app); 

        setTitle("About application"); 

        getSupportActionBar().setDisplayHomeAsUpEnabled(true); 

    } 

    @Override 

    public boolean onOptionsItemSelected(MenuItem item) { 

        int num = item.getItemId(); 

        if (num == android.R.id.home) { 

            finish(); 

        } 

        return super.onOptionsItemSelected(item); 

    } 

} 

 

activity_about_app.xml 

<?xml version="1.0" encoding="utf-8"?> 

<android.support.constraint.ConstraintLayout 

xmlns:android="http://schemas.android.com/apk/res/android" 



    xmlns:app="http://schemas.android.com/apk/res-auto" 

    xmlns:tools="http://schemas.android.com/tools" 

    android:layout_width="match_parent" 

    android:layout_height="match_parent" 

    

tools:context="com.example.asusx501a.englishtenses.Information.About_App"> 

 

    <TextView 

        android:id="@+id/textInfo" 

        android:layout_width="match_parent" 

        android:layout_height="wrap_content" 

        android:layout_marginBottom="8dp" 

        android:gravity="center" 

        android:text="@string/information_ab_app" 

        android:justificationMode="inter_word" 

        android:textAlignment="center" 

        android:textSize="25sp" 

        app:layout_constraintBottom_toBottomOf="parent" 

        app:layout_constraintTop_toTopOf="parent" /> 

</android.support.constraint.ConstraintLayout> 

 

ExternalDbOpenHelper 

package com.example.asusx501a.englishtenses; 

 

import android.content.Context; 

import android.database.SQLException; 

import android.database.sqlite.SQLiteDatabase; 

import android.database.sqlite.SQLiteOpenHelper; 

import android.util.Log; 

 

import java.io.FileOutputStream; 

import java.io.IOException; 

import java.io.InputStream; 

import java.io.OutputStream; 

 

public class ExternalDbOpenHelper extends SQLiteOpenHelper { 

 

     

    public static String DB_PATH; 

    

    public static String DB_NAME; 

    public SQLiteDatabase database; 

    public final Context context; 

 

    public SQLiteDatabase getDb() { 

        return database; 

    } 

 

    public ExternalDbOpenHelper(Context context, String databaseName) { 

        super(context, databaseName, null, 1); 

        this.context = context; 

        

        String packageName = context.getPackageName(); 

        DB_PATH = String.format("//data//data//%s//databases//", 

packageName); 

        DB_NAME = databaseName; 

        openDataBase(); 

    } 

z 

    public void createDataBase() { 

        boolean dbExist = checkDataBase(); 



        if (!dbExist) { 

            this.getReadableDatabase(); 

            try { 

                copyDataBase(); 

            } catch (IOException e) { 

                Log.e(this.getClass().toString(), "Nusxalashda xatolik sodir 

bo`ldi"); 

                throw new Error("Nusxalashda xatolik sodir bo`ldi!"); 

            } 

        } else { 

            Log.i(this.getClass().toString(), "Baza bor ekan"); 

        } 

    } 

    private boolean checkDataBase() { 

        SQLiteDatabase checkDb = null; 

        try { 

            String path = DB_PATH + DB_NAME; 

            checkDb = SQLiteDatabase.openDatabase(path, null, 

                    SQLiteDatabase.OPEN_READONLY); 

        } catch (SQLException e) { 

            Log.e(this.getClass().toString(), "Bazani tekshirishda xatolik"); 

        } 

        if (checkDb != null) { 

            checkDb.close(); 

        } 

        return checkDb != null; 

    } 

    private void copyDataBase() throws IOException { 

        

        InputStream externalDbStream = context.getAssets().open(DB_NAME); 

 

        String outFileName = DB_PATH + DB_NAME; 

 

        OutputStream localDbStream = new FileOutputStream(outFileName); 

 

        byte[] buffer = new byte[1024]; 

        int bytesRead; 

        while ((bytesRead = externalDbStream.read(buffer)) > 0) { 

            localDbStream.write(buffer, 0, bytesRead); 

        } 

        localDbStream.close(); 

        externalDbStream.close(); 

 

    } 

 

 

    public SQLiteDatabase openDataBase() throws SQLException { 

        String path = DB_PATH + DB_NAME; 

        if (database == null) { 

            createDataBase(); 

            database = SQLiteDatabase.openDatabase(path, null, 

                    SQLiteDatabase.OPEN_READWRITE); 

        } 

 

        return database; 

    } 

 

 

 

    @Override 

    public synchronized void close() { 

        if (database != null) { 

            database.close(); 



        } 

        super.close(); 

    } 

    @Override 

    public void onCreate(SQLiteDatabase db) {} 

    @Override 

    public void onUpgrade(SQLiteDatabase db, int oldVersion, int newVersion) 

{} 

} 

 

 


